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BAB III 

METODE PENELITIAN 

A. Pendekatan Penelitian  

Secara umum pendekatan penelitian dapat diartikan sebagai suatu 

kegiatan ilmiah yang sudah terstruktur, terencana, dan sistematis serta 

mempunyai tujuan tertentu. Menurut Aida dkk., (2025) penelitian kuantitatif 

dapat  diartikan  sebagai metode penelitian yang berdasar pada filsafat 

positivisme   dalam   penggunaannya   untuk meneliti  pada  populasi  atau  

sampel  tertentu yang berbentuk perbandingan. Hal ini berarti menguji 

kemampuan generalisasi (signifikan hasil penelitian) yang berupa 

perbandingan karena variable dari dua sampel atau lebih. Pada penelitian ini 

pendekatan kuantitatif bertujuan untuk melihat pengaruh model Project 

Based Learning (PjBL) terhadap keterampilan kolaborasi dan kemampuan 

pemecahan masalah matematis siswa MTs Al-Muhajirin Pandan. 

B. Metode dan Bentuk Penelitian 

1. Metode Penelitian 

Metode penelitian yang akan digunakan dalam penelitian ini adalah 

metode penelitian eksperimen. Metode penelitian eksperimen adalah 

kegiatan penelitian yang bertujuan untuk mengetahui pengaruh suatu 

tindakan pendidikan terhadap tingkah laku siswa, atau menguji hipotesis 

tentang apakah sebuah tindakan atau perlakuan berdampak pada tindakan 

lain. Terkait “metode penelitian eksperimen merupakan metode penelitian 
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yang menggunakan pendekatan kuantitatif, digunakan terutama apabila 

peneliti ingin melakukan percobaan untuk mencari pengaruh variabel 

independent/treatment/perlakuan tertentu terhadap variabel 

dependen/hasil/output dalam kondisi yang terkendali” (menurut Sugiyono, 

2020). 

2. Bentuk Penelitian 

Bentuk penelitian yang akan digunakan peneliti pada penelitian ini 

adalah Quasi Experimental Design, pada eksperimen ini pengujian 

dilakukan pada variabel independent dan variabel dependen sesuai dengan 

sampel penelitian, yaitu kelompok eksperimen dan kelompok kontrol. 

Menurut Sugiyono (2020) mendefinisikan bahwa Quasi Experimental 

Design merupakan pengembangan dari True Experimental Design, yang 

sulit dilaksanakan. Desain ini memiliki kelompok kontrol, tetapi tidak 

berfungsi sepenuhnya untuk mengontrol variabel-variabel luar yang 

mempengaruhi pelaksanaan eksperimen. 

Pada penelitian ini desain yang digunakan yaitu Pretest-Posttest 

Control Group Design. Pada desain ini kelompok eksperimen maupun 

kelompok control tidak dipilih secara random. Kelompok pertama diberikan 

perlakuan (X) dan kelompok kedua tidak diberi perlakuan. Kelompok yang 

diberi perlakuan disebut kelompok eksperimental dan yang tidak diberi 

perlakuan disebut kelompok kontrol. Kelompok pertama diterapkan model 

Project Based learning (PjBL) dan kelompok kedua tidak diterapkan model 
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Project Based learning (PjBL). Berikut ini adalah bentuk desain Pretest-

Posttest Control Group Design. 

Tabel 3. 1 Quasi Experimental Design 

Petest Treatment Posttest 

𝑶𝟏 

𝑶𝟑 

X 𝑶𝟐 

𝑶𝟒 

 

Keterangan: 

𝑂1 = Sebelum diberikan perlakuan di kelas eksperimen 

𝑂2 = Setelah diberikan perlakuan di kelas eksperimen 

X = Model  Project Based Learning (PjBL) 

𝑂3 = Perakuan di kelas kontrol 

𝑂4 = Perakuan di kelas kontrol 

3. Prosedur Penelitian 

a. Tahap Perencanaan  

1) Melakukan kegiatan observasi di lapangan untuk melihat secara 

langsung permasalahan yang ada di sekolah tersebut (kondisi awal 

pembelajaran) 

2) Membuat instrumen penelitian yaitu soal uji coba untuk menentukan 

soal pretest dan posttest serta angket keterampilan kolaborasi yang 

akan digunakan dalam penelitian. 

3) Menyiapkan perangkat pembelajaran yang sesuai dengan model 

project based learning (PjBL). 
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4) Melaksanakan validasi isi dengan meminta bantuan validator guna 

memvalidasi perangkat pembelajaran dan instrument penelitian 

yang akan peneliti gunakan pada saat penelitian. 

5) Perbaikan perangkat pembelajaran dan instrument jika masih 

terdapat kekurangan maupun kesalahan dalam pembuatannya. 

6) Membuat surat izin untuk pelaksanaan uji coba soal penelitian. 

7) Pelaksanaan uji coba angket kolaborasi dan soal tes  

b. Tahap Pelaksanaan 

1) Melaksanakan pengisian pretest untuk kemampuan pemecahan 

masalah matematis siswa sebelum diberi perlakuan. 

2) Memberikan perlakuan dengan model project based learning (PjBL) 

pada kelas eksperimen dan model pembelajaran konvensional pada 

kelas kontrol. 

3) Setelah dilaksanakan perlakuan dilanjutkan dengan melakukan 

pengisian angket keterampilan kolaborasi dan posttest untuk 

mengetahui peningkatan keterampilan kolaborasi dan kemampuan 

pemecahan masalah matematis siswa. 

4) Dilanjutkan dengan pengisian angket respon siswa. 

c. Tahap Evaluasi 

1) Mengolah data yang didapat dari angket keterampilan kolaborasi, 

pretest, dan posttest. 

2) Mendeskripsikan data untuk menjawab rumusan masalah. 

3) Menganalisis data dengan rumus statistik yang telah ditentukan. 
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4) Menyimpulkan hasil pengolahan data dan penganalisisan data untuk 

menjawab rumusan masalah dalam penelitian ini. 

C. Populasi dan Sampel 

1. Populasi 

Populasi adalah keseluruhan subjek yang ada dalam penelitian. Dalam 

penelitian, populasi akan menjadi wilayah generalisasi kesimpulan hasil 

penelitian atau dapat dikatakan populasi meliputi seluruh dari subyek 

penelitian. Dilihat dari jumlah, populasi dalam penelitian ini tergolong 

populasi yang terhingga atau terbaas, artinya memiliki sumber-sumber data 

yang jelas batasnya secara kuantitatif.  

Populasi yang dimaksud dalam penelitian ini adalah keseluruhan siswa 

kelas VIII MTs Al-Muhajirin Pandan pada semester genap pada tahun ajaran 

2024-2025 yang berjumlah 46  siswa. 

Tabel 3. 2 Populasi siswa MTs Al-Muhajirin Pandan 

Kelas  Jumlah siswa 

8A 

8B 

Jumlah  

23 

23 

46 Siswa 

 

2. Sampel   

Sampel adalah sebagian dari populasi yang karakteristiknya hendak 

diselediki, dan dianggap bisa mewakili keseluruhan populasi (Sugiyono, 

2020). Teknik pengambilan sampel yang digunakan oleh penulis dalam 

penelitian ini yaitu teknik non probability sampling. Menurut Sugiyono 

(2020) non probability sampling adalah teknik pengambilan sampel yang 
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tidak memberi peluang/kesempatan sama bagi setiap unsur atau anggota 

populasi untuk dipilih menjadi sampel. Teknik non probability sampling 

dalam penelitian ini yaitu sampling jenuh. Sampling jenuh adalah Teknik 

penentuan sampel bila semua anggota populasi digunakan sebagai sampel. 

sampling jenuh sering dilakukan apabila jumlah populasi relatif kecil, 

kurang dari 30 orang, atau penelitian yang ingin membuat generalisasi 

dengan kesalahan yang sangat kecil (Sugiyono, 2020). Pada penelitian ini 

sampel yang diambil adalah siswa kelas VIII A sebagai kelas eksperimen 

dan VIII B sebagai kelas kontrol. 

D. Teknik dan Alat Pengumpulan Data 

1. Teknik pengumpulan data 

Teknik pengumpulan data merupakan metode yang dilakukan oleh 

peneliti untuk memperoleh data. Teknik pengumpulan data yang digunakan 

penulis dalam penelitian ini adalah: 

a) Teknik Kuesioner  

Menurut Sugiyono (2020) kuesioner merupakan teknik 

pengumpulan data yang dilakukan dengan cara memberi seperangkat 

pertanyaan atau pernyataan tertulis kepada responden untuk dijawab. 

Pertanyaan atau pernyataan dalam kuesioner diupayakan agar  

mewakili semua jawaban yang mungkin dipilih oleh responden. Pada 

lembar angket ada beberapa indikator keterampilan kolaborasi yaitu 

berpartisipasi secara aktif, bekerja secara produktif, bertanggung jawab, 

fileksibel dan kompromi, saling menghargai antar anggota kelompok. 
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b) Teknik Pengukuran  

Teknik pengukuran adalah suatu cara untuk melakukan penilaian 

yang berbentuk soal yang harus dikerjakan siswa untuk mendapatkan 

data hasil kemampuan pemecahan masalah. Soal diberikan sebelum dan 

sesudah dilakukan model Project Based Learning (PjBL). 

c) Teknik Dokumentasi 

Dokumentasi merupakan pengamatan secara langsung untuk 

mendapatkan data yang diperoleh peneliti sesuai dengan pembahasan. 

Dokumentasi ini dilakukan untuk mengetahui gambaran nyata 

dilapangan dan mendapatkan sumber primer tentang hubungan budaya 

organisasi sekolah terhadap motivasi kerja guru (Prawiyogi dkk., 2021). 

Teknik ini dilakukan untuk mendokumentasikan aktivitas belajar siswa 

dalam bentuk foto selama penelitian berlangsung, surat penelitian, 

modul ajar, lembar kerja siswa yang sudah dikoreksi. 

2. Alat pengumpulan data 

a) Lembar angket 

Menurut Milawati (2019) angket merupakan teknik pengumpulan 

data berupa daftar pertanyaan secara tertulis yang harus diisi oleh 

responden sesuai petunjuk pengisian. Angket yang digunakan dalam 

penelitian ini adalah angket dengan skala likert. Angket yang digunakan 

dalam penelitian ini ada dua yaitu angket keterampilan kolaborasi siswa 

dan angket respon siswa terhadap model project based learning (PjBL). 

1) Angket Keterampilan Kolaborasi 
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Pertanyaan atau pernyataan dalam kuesioner diupayakan agar mewakili 

semua jawaban yang mungkin dipilih oleh responden. Pada lembar 

amgket keterampilan kolaborasi ada beberapa indikator yaitu 

berpartisipasi secara aktif, bekerja secara produktif, bertanggung jawab, 

fleksibel dan kompromi, dan saling menghargai antar anggota 

kelompok. Adapun kriteria penilaian angket keterampilan kolaborasi 

sebagai berikut ini. 

Rumus: 

Keterampilan kolaborasi = 
𝑇𝑜𝑡𝑎𝑙 𝑠𝑘𝑜𝑟 𝑦𝑎𝑛𝑔 𝑑𝑖𝑝𝑒𝑟𝑜𝑙𝑒ℎ

𝑇𝑜𝑡𝑎𝑙 𝑠𝑘𝑜𝑟 𝑚𝑎𝑘𝑠𝑖𝑚𝑎𝑙
× 100% 

Tabel 3. 3 Kriteria angket keterampilan kolaborasi siswa 

Skor  Kriteria  

AK ≥ 80 Sangat Tinggi 

60 < ×≤ 80 Tinggi 

40 < ×≤ 60 Sedang  

20 < ×≤ 40 

AK ≤ 20 

 Rendah 

Sangat Rendah 

Sumber: Arikunto dalam Qurrota A’yun (2021) 

2) Angket respon siswa 

Pada penelitian ini angket respon siswa terhadap penggunaan 

model Project Based Leraning (PjBL) diisi oleh kelas eksperimen. 

Angket respon pada penelitian ini menggunakan aspek penilaian 

skala likert dikembangkan berdasarkan (Sugiyono, 2020) pada Tabel 

3.4 

Tabel 3. 4 Skor Respon Peserta Didik 

Pilihan Jawaban Bobot Skor 

Sangat Setuju (SS) 4 

Setuju (S) 3 

Tidak Setuju (ST) 2 
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Sangat Tidak Setuju (STS) 1 

Sumber: Sugiyono (2020) 

Angket respon siswa bertujuan untuk mengevaluasi efektivitas 

model Project Based Learning (PjBL) yang telah disusun. Oleh 

karena itu, diterapkan analisis data untuk menghitung respon siswa 

dengan menggunakan rumus sebagai berikut: 

Rumus : 

RS = 
𝑓

𝑛
× 100% 

Keterangan : 

RS = Presentase respon siswa 

f = Jumlah nilai tiap sub variabel 

n = Jumlah skor maksimum 

Tabel 3. 5 Kriteria angket respon siswa 

Interval kriteria Kriteria  

86% - 100% Sangat Baik 

76% - 85% Baik 

66% - 75% 

56% - 65% 

Cukup  

Kurang  

0% - 55% Sangat Kurang  

Sumber: Danggu (2023) 

b) Soal tes 

 Tes adalah seperangkat alat atau prosedur yang digunakan  untuk  

mengetahui  atau  mengukur  suatu  dalam  suasana,  dengan  cara  dan 

aturan-aturan yang sudah ditentukan (Arikunto dalam Nopriyanti, 

2024). Bentuk soal yang akan diberikan kepada siswa berupa soal essay 

untuk mengukur kemampuan pemecahan masalah matematis. Pada 

penelitian ini menggunakan soal yang sama. Posttest untuk mengukur 
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tingkat keberhasilan siswa melalui tes instrument yang diberikan pada 

akhir materi. Adapun indikator pada soal tes yaitu peserta didik dapat 

menjelaskan pengertian relasi dalam matematika, peserta didik dapat 

menyajikan relasi dalam bentuk diagram panah, diagram cartesius dan 

pasangan berurutan, peserta didik dapat menyelesaikan masalah yang 

berkaitan dengan relasi menggunakan berbagai representasi. 

E) Teknik Analisis Data 

Analisis data adalah salah satu proses penelitian kuantitatif yang 

dilakukan setelah semua data terkumpul guna memecahkan permasalahan 

yang diteliti. Ketepatan penggunaan analisis data menentukan keakuratan 

dalam proses pengambilan, karena kegiatan analisis data adalah bagaimana 

kegiatan yang tidak dapat diabaikan begitu saja dalam proses penelitian. 

Priadana & Sunarsi  (2021:201) menyatakan bahwa analisis data adalah 

kegiatan analisis pada suatu penelitian yang dikerjakan dengan memeriksa 

seluruh data dari instrument penelitian, seperti catatan, dokumentasi, hasil 

tes, rekaman dan lain-lain. Kegiatan ini dilakukan agar data lebih mudah 

dipahami. 

Analisis data dalam penelitian ini berdasarkan dari seluruh 

responden, mentabulasi dari seluruh responden variabel, menyajikan data 

variabel yang diteliti, melakukan perhitungan untuk men jawab rumusan 

masalah, serta melakukan perhitungan terhadap hipotesis penelitian yang 

sudah diajukan (Sugiyono, 2019:206). Penelitian ini menggunakan Teknik 

analisis data yaitu sebagai berikut ini: 
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1. Uji Instrumen Penelitian 

a) Uji validitas  

Uji validitas digunakan untuk mengetahui valid atau tidaknya suatu 

instrument penelitian. Validitas adalah indeks yang menunjukkan sejauh 

mana suatu alat pengukur itu mengukur apa yang ingin di ukur 

(Magdalena dkk., 2021). 

Rumus : 

r = 
𝑛Σ𝑥𝑦−(Σ𝑥)(Σ𝑦)

√(𝑛Σ𝑥2−(Σ𝑥)2−(𝑛Σ𝑦2−(Σ𝑦)2
 

Keterangan: 

r = koefisien korelasi 

Σ𝑥 = jumlah skor item 

Σ𝑦 = jumlah skor total item 

n = jumlah responden 

jika r hitung > r tabel maka item pertanyaan valid. Jika r hitung < r tabel 

maka item pertanyaan tidak valid. 

Pengklasifikasian validitas seperti yang ditunjukkan pada kriteria sebagai 

berikut. 

 

Tabel 3. 6 Kategori Uji Validitas 

Nilai  Keterangan  

81% – 100% 

61% – 80%  

41% – 60% 

21% – 40% 

Sangat Valid 

Valid 

Cukup Valid  

Kurang Valid 
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0% – 20% Sangat Tidak Valid 

Sumber: Bagaskara dalam Farapikatan (2024) 

Langkah-langkah dalam uji validitas dengan bantuan SPSS antara lain 

sebagai berikut. 

1) Melakukan tabulasi data ke microsoft excel 

2) Copy data dari excel termasuk skor total dan paste-kan ke SPSS (data 

view) 

3) Sebelum diolah, periksa kembali nama item di menu variabel view 

4) Selanjutnya pada menu data view, klik menu analyze, lalu klik 

correlate lalu bivariate disebelahnya 

5) Blok semua item pernyataan termasuk total lalu klik tanda panah di 

tengahnya dan dipindahkan ke kolom variables 

6) Klik pearson di menu correlate coefisients, klik two-tailed di menu 

test of significance dan selanjutnya klik flag significant correlation 

dan klik OK 

7) Selanjutnya akan muncul data ouput yang menunjukkan nilai 

pearson correlation pada total dari setiap item pernyataan 

b) Uji Reliabilitas 

Menurut Rusilowati (2017) mendefinisikan bahwa reliabilitas alat 

penelitian adalah ketepatan alat tersebut dalam menilai apa yang dinilai 

artinya kapanpun alat penilaian tersebut digunakan akan memberikan 

hasil yang sama. Rumus yang digunakan dalam mengukur reliabilitas 

soal test essai yang dapat dilihat pada bagian bawah berikut: 
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Rumus soal tes uraian  

α = (k/(k-1)) (1-∑s𝑗2/ s𝑥2) 

keterangan : 

k = banyak soal  

s𝑗2 = varians butir ke j  

s𝑥2 = varians skor tes 

untuk mengetahui kategori kriteria yang diperoleh dari hasil uji 

reliabilitas tes soal uraian dapat dilihat pada Tabel 3.7. 

Tabel 3. 7 Kriteria Uji Relibilitas Tes 

Koefisien 

Reliabilitas  

Tingkat Kriteria   

r < 0,2 Sangat rendah 

0,2 ≤ r < 0,4 Rendah  

0,4 ≤  r < 0,6 Cukup  

0,6 ≤ r < 0,8 Tinggi  

0,8 ≤ r ≤ 1,0 Sangat tinggi   

Sumber : Rusilowati, A. (2017)  

Langkah-langkah uji reliabilitas menggunakan SPSS  

1. Melakukan tabulasi data ke microsoft exel 

2. Buka aplikasi SPSS, edit data di variabel veiw, data view, klik menu 

analyze  

3. Klik menu scale 

4. Klik menu reliability analyze 

 

c) Uji Daya Pembeda 
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Daya pembeda adalah angka yang menunjukkan perbedaan 

kelompok tinggi dengan kelompok rendah. Menentukan daya pembeda 

soal dengan rumus menurut Magdalena dkk., (2020): 

D = 
𝐵𝐴

𝐽𝐴
−

𝐵𝐵

𝐽𝐵
 

Keterangan: 

D = jumlah siswa 

𝐵𝐴 = banyaknya siswa kelompok atas 

𝐵𝐴 = banyaknya siswa kelompok bawah 

𝐽𝐴 = banyaknya kelompok atas yang menjawab soal dengan benar 

𝐽𝐵 = banyaknya kelompok atas yang menjawab soal dengan salah 

Pengklasifikasian daya pembeda seperti yang ditunjukkan pada kriteria 

sebagai berikut 

Tabel 3. 8 Kategori Uji Daya Pembeda 

Nilai  Keterangan  

0,70 – 1,00 

0,40 – 0,69  

0,20 – 0,39 

0,00 – 0,19 

Baik Sekali 

Baik  

Cukup  

Rendah 

Sumber: Magdalena dkk., (2021) 

 

Langkah-langkah dalam uji daya pembeda dengan bantuan SPSS antara 

lain sebagai berikut. 

1) Buka program SPSS, impor atau masukkan data yang ingin anda 

analisis 

2) Pilih menu “Analyze” di bagian atas jendela SPSS 
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3) Pilih “Correlate” dan kemudian “Bivariate” 

4) Pilih semua item ke kolom variabel sebelah kanan 

5) Centang pearson → Two-tailed → Flag significant correlations → ok 

d) Uji Tingkat Kesukaran 

Tingkat kesukaran soal artinya mengkaji soal-soal tes dari segi 

kesulitannya sehingga dapat diperoleh soal-soal mana yang termasuk 

mudah, sedang dan sukar (Komarudin dalam Saputri, 2023) 

P = 
𝐵

𝐽𝑆
 

Keterangan: 

P = indeks kesukaran 

B = jumlah skor peserta didik menjawab soal tes dengan benar tiap soal 

JS = jumlah seluruh siswa peserta tes 

Pengklasifikasian tingkat kesukaran seperti yang ditunjukkan pada 

kriteria sebagai berikut:  

Tabel 3. 9 Kategori Uji Tingkat Kesukaran 

Nilai  Keterangan  

0,71 – 1,00 

0,31 – 0,70  

0,00 – 0,30 

Mudah  

Sedang  

Sukar  

Sumber: Magdalena (2021) 

 

Langkah-langkah dalam uji tingkat kesukaran dengan bantuan SPSS 

antara lain sebagai berikut. 

1) Buka program SPSS 
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2) Pastikan data anda terorganisir dengan baik dalam format yang sesuai 

di SPSS 

3) Pilih menu “Analyze” 

4) Pilih menu Descriptive Statistics → frequencies 

5) Pindahkan semua item soal ke kolom variabel → Statistics → centar 

tendency → centang mean → continue → ok 

2. Uji Prasyarat 

a) Uji Normalitas 

Uji normalitas data dimaksudkan untuk memperlihatkan bahwa data 

dan sampel berasal dari populasi yang berdistribusi normal. 

Rumus :  

𝑥2 = 
[(𝑛1−𝑛2)−1]2 

(𝑛1+ 𝑛2)
 

Keterangan : 

𝑥2 = Chi Kuadrat 

𝑛1 = banyak data positif 

𝑛2 = banyak data negatif 

Pengklasifikasian normalitas seperti yang ditunjukkan pada kriteria 

sebagai berikut. 

Tabel 3. 10 Kategori Uji Normalitas 

Nilai  Keterangan  

Sig > 0,05 

Sig < 0,05 

Normal  

Tidak Normal  

Sumber: Saliko (2025) 

 

Langkah-langkah dalam uji normalitas dengan bantuan SPSS antara lain 

sebagai berikut. 
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1) Buka program SPSS 

2) Copy semua data yang ingin di uji 

3) Pilih menu berikut: Analyze → Descriptives Statistics → Explore 

4) Setelah muncul kotak dialog Explore masukkan hasil belajar ke 

Dependent list 

5) Masukkan kelas ke factor list 

6) Pilih tombol Plots, centang normality plots with tests 

7) Berikan tanda centang, lalu tekan Continue 

8) Pilih OK 

b) Uji Homogenitas  

Uji homogenitas dimaksudkan untuk memperlihatkan bahwa dua 

atau lebih kelompok data sampel berasal dari populasi yang 

memiliki varians yang sama. Pada penelitian ini uji homogenitas 

yang digunakan yaitu uji levene. Uji levene untuk menguji apakah 

varians antara kelompok atau perlakuan sama atau tidak. 

Rumus : 

W =
(𝑁−𝑘)

(𝑘−1)
×

∑ 𝑁𝑖𝑧̅𝑙−𝑧̅..)2𝑖
𝑖=1

∑ ∑ 𝑍𝑖𝑗−𝑧̅𝑙)2𝑁𝑖
𝑗=1

𝑖
𝑖=1

 

Keterangan: 

W = uji levene 

N = jumlah total observasi 

k = jumlah kelompok  

𝑁𝑖  = jumlah observasi dalam kelompok ke-i 
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𝑧𝑙̅ = rata-rata dalam kelompok ke-i 

𝑧̅.. = rata-rata umum dari semua data 

𝑍𝑖𝑗 = setiap nilai observasi dalam kelompok ke-i 

Pengklasifikasian homogenitas seperti yang ditunjukkan pada 

kriteria sebagai berikut: 

Tabel 3. 11 Kategori Uji Homogenitas 

Nilai  Keterangan  

Sig > 0,05 

Sig < 0,05 

Homogenitas  

Tidak Homogenitas  

Sumber: Saliko (2025) 

Langkah-langkah dalam uji homogenitas dengan bantuan SPSS antara 

lain sebagai berikut. 

1) Buka SPSS 

2) Copy semua data yang ingin di uji 

3) Pilih menu Analyze → Compare means → One – Way – ANOVA 

4) Hasil belajar dependent list dan kelas sebagai factor list 

5) Klik tombol options → Homogenity of variance test 

6) Klik Continue lalu klik OK 

c) Uji One Sample t-Test 

Pengujian rata-rata satu sampel dimaksudkan untuk menguji nilai 

tengah atau rata-rata populasi µ sama dengan nilai tertentu µo, lawan 

hipotesis alternatifnya bahwa nilai tengah atau rata-rata populasi µ tidak 

sama dengan µo. Pengujian satu sampel pada prinsipnya ingin menguji 

apakah suatu nilai tertentu (yang diberikan sebagai pembanding) berbeda 
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secara nyata ataukah tidak dengan rata-rata sebuah sampel. Nilai tertentu 

di sini pada umumnya adalah sebuah nilai parameter untuk mengukur 

suatu populasi. 

Rumus: 

𝑡ℎ𝑖𝑡 =
𝑥̅ − 𝜇0

𝑠/√𝑛
 

Keterangan : 

t = nilai t hitung 

𝑥̅ = rata-rata sample 

𝜇0 = nilai parameter 

s = standar deviasi sample 

𝑛 = jumlah sample 

Langkah-langkah uji t One Sample t-Test dengan bantuan SPSS sebagai 

berikut: 

1) Buka program SPSS 

2) Masukkan data pada Data View 

3) Klik Menu Analyze → Compare Means → One Sample t-Test 

4) Masukkan variabel ke kolom Test Variabel dan masukkan nilai rata-

rata 60 pada Test Value 

5) Klik Option kemudian klik Continue 

6) Kemudian klik Ok 

Kriteria pengambilan keputusan uji t jika nilai 𝑡ℎ𝑖𝑡𝑢𝑛𝑔 > 𝑡𝑡𝑎𝑏𝑙𝑒 maka 

𝐻0 ditolak atau jika nilai sig < 0,05 maka 𝐻0 ditolak. 

d) Uji Independet Sample t-Test 
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Data yang telah terkumpul diuji agar hasil analisis yang diperoleh 

lebih ilmiah dengan melakukan uji t. apabila data berdistribusi normal 

dan memiliki varians yang tidak homogen, maka pengujian dilakukan 

menggunakan uji t atau Independent Sample Test untuk menjawab 

hipotesis kedua dan keempat. 

Rumus : 

𝑡ℎ𝑖𝑡 =  
𝑀1 − 𝑀2

√
𝑆𝑆1 + 𝑆𝑆2

𝑛1 + 𝑛2
(

1
𝑛1

+
1

𝑛2
)

 

Keterangan : 

 𝑀1rata-rata skor kelompok 1 

𝑀2 = rata-rata skor kelompok 2 

𝑆𝑆1 = sum of square kelompok  1 

𝑆𝑆2 = sum of square kelompok   2 

𝑛1 = jumlah subjek/sampel kelompok 1 

𝑛2 = jumlah subjek/sampel kelompok 2 

Langkah-langkah dalam uji t dengan bantuan SPSS antara lain sebagai 

berikut. 

1) Buka program SPSS 

2) Masukkan data hasil penelitian pada kolom yang sesuai pada data 

view 

3) Pilih menu Analyze → Compare Means → Independent Sampel-T Test 

4) Pindahkan variabel ke kolom yang sesuai pada kotak dialog 

Independent Sampel-T Test 
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5) Klik Options → Continue pilih Ok 

Kriteria pengambilan keputusan uji t jika nilai 𝑡ℎ𝑖𝑡𝑢𝑛𝑔 > 𝑡𝑡𝑎𝑏𝑙𝑒 maka 

𝐻0 ditolak atau jika nilai sig < 0,05 maka 𝐻0 ditolak. 

e) Uji Paired Sample t-Test 

Uji – t berpasangan (paired t-test) adalah salah satu metode pengujian 

hipotesis dimana data yang digunakan tidak bebas (berpasangan). 

Rumus: 

𝑡ℎ𝑖𝑡 =
𝐷̅

𝑆𝐷

√𝑛

 

Keterangan: 

t   = nilai t hitung 

𝐷̅    = rata-rata selisih pengukuran 1 dan 2 

SD = standar deviasi selisih pengukuran 1 dan 2 

𝑛   = jumlah sample  

Langkah-langkah uji t dengan bantuan SPSS antara lain sebagai berikut: 

1) Buka program SPSS 

2) Masukkan data hasil penelitian pada kolom yang sesuai pada data 

view 

3) Pilih menu Analyze → Compare Means → Paired Sampel-T Test 

4) Masukkan X1 ke variabel 1 dan X2 ke variabel 2 

5) Klik option dan pada interval confidence masukkan 95% (karena 𝛼= 

0,05). Kemudian klik continue 

6) Kemudian klik OK 
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Kriteria pengambilan keputusan uji t jika nilai 𝑡ℎ𝑖𝑡𝑢𝑛𝑔 > 𝑡𝑡𝑎𝑏𝑙𝑒 maka 

𝐻0 ditolak atau jika nilai sig < 0,05 maka 𝐻0 ditolak. 

f) Uji non Parametriks 

Jika salah satu data pretest, posttest atau keduanya tidak normal, 

maka dilanjutkan dengan menggunakan uji non parametriks. Uji 

parametrik dapat dilakukan dengan uji U mann whitney untuk menguji 

perbedaan antara dua kelompok independent ketika data tidak 

berdistribusi normal dengan syarat: 

1) Data sampel tidak berdistribusi normal 

2) Dua kelompok sampel yang saling independen atau tidak 

berhubungan atau tidak berpengaruh satu sama lain (anggota 

sampel dua kelompok berbeda) 

3) Sampel berskala data ordinal, atau interval 

4) Jumlah sampel pada dua kelompok sama. 

Langkah-langkah sebagai berikut: 

1) Menentukan jumlah sampel (𝑛1 dan 𝑛2) 

2) Merangking data dari kedua sampel (∑ 𝑅1 dan ∑ 𝑅2) 

3) Menentukan harga u 

𝑈1 = 𝑛1. 𝑛2 +
𝑛1(𝑛1+1)

2
− ∑ 𝑅1 

𝑈2 = 𝑛1. 𝑛2 +
𝑛1(𝑛1+1)

2
− ∑ 𝑅2 

Keterangan: 

𝑈1 =  jumlah peringkat 1 

𝑈2 = jumlah peringkat 2 
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𝑛1 =  jumlah sampel 1 

𝑛2 =  jumlah sampel 2 

𝑅1 =  jumlah rangking pada sampel 𝑛1  

𝑅2 =  jumlah rangking pada sampel 𝑛2 

4) Menentukan harga U terkecil 

5) Menentukan nilai 𝑍ℎ𝑖𝑡𝑢𝑛𝑔 

𝜇𝑢 =
𝑛1.𝑛2

2
𝜎𝑢 = √

𝑛1.𝑛2(𝑛1+𝑛2+1)

12
  

𝑍𝑡𝑎𝑏 = 𝑍 
1

2
(1 − 𝛼)  

Dengan 𝛼 = 95% atau 0,05 dengan menggunakan daftar tabel. 

6) Keputusan Hipotesis 

Jika 𝑡ℎ𝑖𝑡𝑢𝑛𝑔 <  𝑡𝑡𝑎𝑏𝑒𝑙 maka Ho dapat diterima dan Ha ditolak 

pada taraf signifikan 𝛼 sebesar 0,05 

Jika 𝑡ℎ𝑖𝑡𝑢𝑛𝑔 >  𝑡𝑡𝑎𝑏𝑒𝑙 maka Ho ditolak dan Ha diterima pada taraf 

signifikan 𝛼 sebesar 0,05  

Uji hipotesis adalah metode pengambilan Keputusan yang didasarkan 

dari analisis data, baik dari percobaan yang terkontrol, maupun dari 

observasi (tidak terkontrol). Jika data berdistribusi normal, maka 

langkah selanjutnya yaitu pengujian dengan menggunakan statistik 

parametriks yaitu uji t, sedangkan jika data tidak berdistribusi normal 

maka pengujian hipotesis menggunakan non parametriks. 

3. Hasil Uji Coba  Instrumen 

a) Uji Validitas 
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Uji coba yang dilakukan di penelitian ini yaitu untuk mengetahui 

apakah soal dan angket yang digunakan sudah valid atau belum. Uji 

coba soal dan angket yang diujikan yaitu soal tes berjumlah 10 soal 

bentuk essay dengan  jumlah anggota sampel 27 siswa kelas VIII SMPN 

3 Sintang yang mana sekolah tersebut sudah menggunakan kurikulum 

merdeka dan materi tersebut belum disampaikan oleh guru mata 

pelajaran sehingga sekolah tersebut menjadi tempat saya melakukan uji 

coba dikarenakan kurikulum yang digunakan sama dengan kurikulum 

yang digunakan di MTs Al-Muhajirin pandan. Setelah dilakukannya uji 

coba soal dan angket kemudian langkah selanjutnya menganalisis data 

menggunakan program SPSS Version 25. Berdasarkan uji validitas butir 

soal yang valid berjumlah 5 butir soal dan uji validitas angket yang valid 

berjumlah 25 pernyataan. Berikut hasil uji validitas soal dan angket:  

 

 

 

Tabel 3. 12 Hasil Uji Validitas Soal 

Nomor 

Soal 

r hitung r table keterangan 

1 0,413 0,161 Sangat tidak valid 

2 0,413 0,731 Valid  

3 0,413 -0,068 Sangat tidak valid 

4 0,413 0,359 Kurang valid 

5 0,413 0,019 Sangat tidak valid 

6 0,413 0,689 Valid  

7 0,413 0,692 Valid  

8 0,413 0,029 Sangat tidak valid 

9 0,413 0,854 Sangat valid 

10 0,413 0,935 Sangat valid 
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b) Uji Reliabilitas 

Uji reliabilitas penelitian ini yaitu untuk menentukan tes belajar soal 

essay yang disusun oleh peneliti apakah soal yang digunakan sudah 

memiliki daya ukur atau reliabilitas yang tinggi atau belum. 

Tabel 3. 13 Hasil Uji Reliabilitas 

 

 

 

 

Berdasarkan nilai Cronbach’s Alpha pada hasil perhitungan 

menggunakan bantuan SPSS Version 25 diperoleh nilai 0,624, ini berarti 

instrument tersebut reliabel. 

c) Uji Daya Pembeda 

Daya pembeda soal merupakan sebuah soal dalam membedakan 

antara siswa yang memiliki kemampuan tinggi, sedang maupun rendah. 

Berikut ini merupakan hasil statistik daya pembeda soal bentuk essay. 

Tabel 3. 14 Hasil Uji Daya Pembeda 

Nomor 

soal 

Jumlah 

siswa 

Corrected Item 

Total Correlation 

Keterangan 

1 

27 siswa 

0,050 Rendah 

2 0,690 Baik 

3 -0,219 Rendah 

4 0,165 Rendah 

5 -0,072 Rendah 

6 0,639 Baik 

7 0,513 Baik 

8 -0,063 Rendah 

Reliability Statistics 

Cronbach's Alpha N of Items 

.624 10 
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9 0,857 Baik sekali 

10 0,816 Baik  

 

d)  Uji Tingkat Kesukaran 

Soal yang baik merupakan soal yang tidak terlalu mudah atau terlalu 

sulit. Maka dari itu, sebaiknya jika soal terlalu sukar akan membuat 

siswa putus asa dan tidak semangat untuk mengulang karena diluar 

jangkauannya. Berikut ini merupakan hasil output SPSS Version 25 yang 

peneliti gunakan untuk menguji tingkat kesukaran  pada soal uji coba 

bentuk essay. 

 

 

 

 

 

 

Tabel 3. 15 Hasil Uji Tingkat Kesukaran 

Nomor 

soal 

Jumlah 

siswa 

Corrected Item 

Total Correlation 

Keterangan 

1 

27 siswa 

0,98 Mudah 

2 0,62 Sedang  

3 0,99 Mudah 

4 0,98 Mudah  

5 0,99 Mudah  

6 0,98 Mudah  

7 0,95 Mudah  

8 0,98 Mudah  

9 0,97 Mudah  

10 0,37 Sedang  
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Berdasarkan  hasil data tersebut maka dapat disimpulkan dari hasil 

validitas, reliabilitas, daya pembeda dan tingkat kesukaran sebagai 

berikut: 

Tabel 3. 16 Kesimpulan Hasil Uji Coba Instrumen 

Nomor 

soal 

validitas Reliabilitas  Daya 

Pembeda 

Tingkat 

kesukaran 

kesimpulan 

1 
0,161 

0,624 Rendah Mudah Tidak 

digunakan 

2 0,731 Baik Sedang  Digunakan  

3 -0,068 Rendah Mudah Tidak 

digunakan 

4 0,359 Rendah Mudah  Tidak 

digunakan 

5 0,019 

 

Rendah Mudah  Tidak 

digunakan 

6 0,689 Baik Mudah  Digunakan  

7 0,692 Baik Mudah  Digunakan  

8 0,029 Rendah Mudah  Tidak 

digunakan  

9 0,854 Baik 

sekali 

Mudah  Digunakan  

10 0,935 Baik  Sedang  Digunakan  

 

 


